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Introduction

1. Introduction
Thank you for purchasing the AC-525 Visual Access Controller
Unit (VACU) and AS-525AV ViTrax PC software.
The AC-525 is an advanced multi-door networked access
controller coupled with a digital video server and cutting-edge
DVR technology. The integrated panel supports two analog
camera inputs. It has a built-in embedded Linux OS with web
server, which enables advanced network communication
options. The AC-525 streams video in ISO standard compliant
MPEG-4 (SP) in complete synchronization with real-time access
control data.
AS-525AV ViTrax is a digital video recording and remote
surveillance Client/Server suite. It supports major Network (IP)
Cameras, and Directshow compatible devices such as USB
cameras and runs on Microsoft Windows® operating system.
The AS-525AV ViTrax Software can function as standalone
software for video stream management, however for full
integration with the AC-525 access control AS-525 AxTrax, AS525AV ViTrax server, and AS-525AV ViTrax client are required.
AS-525AV ViTrax features a proprietary multimedia database,
ViTrax server Watchdog which restarts the server automatically
in case of PC power failure recovery to resume local and
remote data flows, as well as integration with Google Maps
interface that allows you to place cameras on actual maps for
easy browsing.
This manual explains how to install and use AS-525AV ViTrax PC
software with the AC-525 Visual Access Controller Unit. For
more information on the AC-525 system, refer to the AC-525
Access Controller Unit (VACU) Hardware Installation manual
and the AS-525 AxTrax Access control management software
manual.

1.1 Software Security
Using AS-525AV ViTrax wizard, users can custom design the
system to meet their specific needs, the access to AS-525AV
ViTrax software is password controlled.
Page 5
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It is possible to grant different operators restricted security rights
with access to only specified elements of the system or with
read-only access.

1.2 AS-525AV ViTrax Server and Client
AS-525AV ViTrax software provides full video management for
the AC-525 and third party servers and IP cameras. The
software package consists of two applications:
• AS-525AV ViTrax Server
• AS-525AV ViTrax Client software
Both are integrated into a single installation package for your
convenience. You can choose to install both or just one of
these applications depending on your specific needs.

1.2.1. AS-525AV ViTrax Server
AS-525AV ViTrax operates through a dedicated server
computer, which communicates with the access control
panels and can serve an unlimited number of network clients.
AS-525AV ViTrax Server is a behind-the-scenes application that
captures, processes, and records video before serving it to a
local or remote AS-525AV ViTrax Client.
Install AS-525AV ViTrax Server on the computer that controls the
Access Control panels and manages the database. AS-525AV
ViTrax includes a full suite of administrator functions, including
the ability to view multiple local and remote sources, record
video for local or remote playback later, export recordings to
preserve and present as evidence, change video parameters,
and manage the database.

1.2.2. AS-525AV ViTrax Client
AS-525AV ViTrax Client is the User interface and video
management application, from which all users have access to
manage the AS-525AV ViTrax Server, cameras and network
settings, view live video or archived video, feeds provided that
the AS-525AV ViTrax Server is operating and connected to the
panel network.
AS-525AV ViTrax Software Manual
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1.3 System Specifications and Requirements
The following are the system capabilities and the system
requirements.

1.3.1. AS-525AV ViTrax System Requirements
These are the basic requirements for the system, for detailed
computer configurations please see Appendix B Detailed
Computer Specifications, on page 116.
Operating System

Microsoft ®Windows 2000
Windows XP Home / Professional,
Windows Vista
Windows 7
Windows Server 2003

Motherboard

Intel® 915, 945, and 965 Family

Memory

Intel® 945G Express Chipset with a
minimum of 64 MB memory

HDD

250 GB recommended. Depends on
frame-rate, compression, and storage
period

Network

LAN card required for TCP/IP networking

1.3.2. Database Features (DB)
DB Format

Microsoft® MSSQL and Proprietary Files –
Password Protected

Embedded PDF Files Most current Software and Hardware
Manuals

DB Backup

Backup Now Option/ Clear All Now
Option
DB Export Config and/or Events –
Selectable Backup and Restore
Auto File Naming for Backups
Automatic Backups

DB Export Formats

.mp4 and .avi file exports

Database Retention

Programmable Period

Page 7
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1.3.3. Networks
AC-525
Supported Access
Control Panel Models AC-525 with MD-IO84 I/O extension

board or MD-D02 Door Expansion Board

Panel Networks
Communication
Interface

TCP-IP

1.3.4. Video Surveillance
Server Mode

Local Network and Remote network
Server and Client module

Streaming Support

ISO Standard MPEG-4

Selectable Viewports Matrix Viewports
PTZ Presets

Two per viewport support Pelco-D

1.3.5. Video Recording Server
Recording

MJPEG4/MJPEG/JPEG compression

Record Commands

Sent based on pre-defined access control
events

Motion Detection

Selectable Motion areas and Sensitivity in
FOV Zones

Advanced
Compression

Proprietary Storage with Custom Retrieval
Tools

1.4 ViTrax Licenses
Various ViTrax licenses are available, from Level 0 (provided
free of charge), which features one camera with one local
client to Level 5, which features unlimited cameras and
unlimited clients. The table below lists the various available
licenses.
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Part Number Description
AS-525AV-L0
AS-525AV-L1
AS-525AV-L2
AS-525AV-L3
AS-525AV-L4
AS-525AV-L5

Level 0: 1 Camera, 1 Local client
Level 1: 2 Cameras, 1 Client
Level 2: 4 Cameras, 1 Client
Level 3: 9 Cameras, 3 Clients
Level 4: 16 Cameras, 4 Clients
Level 5: Unlimited Cameras, Unlimited Clients

1.5 How to Use this Manual
This manual is constructed in a step-by-step format but can
also be used as a quick reference guide.
Installers who are new and unfamiliar with the setup procedure
should read this manual from cover to cover and should read
each chapter in the order that it is presented. However, if you
are already familiar with AS-525AV ViTrax software, this manual
can be used as a quick reference guide in order to fine tune
your knowledge about the AS-525AV ViTrax system.
A PDF of this manual can also be found on the AS-525AV ViTrax
software installation CD.
Note:

This manual refers to AS-525AV ViTrax software version
1.7.5 and later.
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2. Installing AS-525AV ViTrax PC Software
The installation of AS-525AV ViTrax PC software package from
the CD-ROM is a mostly automated process done by a smart
installer program.
The installer helps with tasks such as entering a unique server
name, administrator login setup, enabling access from remote
AS-525AV ViTrax clients, TCP/IP port selection, and application
running mode. You can always come back to this Wizard later
to change the settings though the Start Menu.
The software consists of two applications, AS-525AV ViTrax
Server and AS-525AV ViTrax Client. During the installation
process, you are presented with a choice to install either both
of the available applications or just one of them.
AS-525AV ViTrax Server requires activation with the activation
key provided when the product was purchased. The server
can only be activated on one computer. If at a later date you
need to move the installation to another computer, contact
Rosslare Technical Support.
Note:

Remember to keep your activation key in a safe
place. If you do lose the activation key, it can be
viewed by selecting About from the menu bar.

AS-525AV ViTrax Client software does not require activation,
and can be installed on as many computers as you want.

2.1 Connecting to the PC
Before using the software, it is important to make sure that the
AC-525 hardware and any additional components, i.e.
cameras, are connected correctly.
Create a connection between the hardware and the
computer. The AC-525 is not connected directly to the
computer; it is connected to the IP network.
Refer to the AC-525 Hardware Installation manual in order to
configure the hardware to the computer.

AS-525AV ViTrax Software Manual
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2.2 Starting AS-525AV ViTrax Installer
Install AS-525AV ViTrax software using the installation CD-ROM.

To begin installing AS-525AV ViTrax:
1. Close all applications.
2. Insert the CD into the computer's CD drive.
If the Setup Wizard does not start automatically, click Start
on the Windows taskbar, and click Run. Enter D:\Setup,
where D is the letter that corresponds to the CD drive. For
example, if the CD drive is the E drive, enter E:\setup.
3. Click Install to continue the installation. The Welcome to
the Install Shield Wizard window opens.

Figure 1: Welcome Rosslare Setup Wizard Window

4. Click Next to display the Software License Agreement
window.
To cancel, click Cancel to quit AS-525AV ViTrax PC
software installer.

Page 11
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Figure 2: Software License Agreement Window

5. After reading the Software License Agreement, choose I
accept the agreement. Click Next to continue with the
installation.
6. Choose the Destination Location.
The installer prompts you to enter the destination location
for the installation. This is where AS-525AV ViTrax PC
software is stored on the hard drive.

Figure 3: Setup Destination Window

7. To accept the default location, continue with step 9.
AS-525AV ViTrax Software Manual
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8. To change the installation location, click Browse, and
select a new installation location.
9. Click Next to continue with the installation.
The Install Components window opens.

Figure 4: Install Components Window

10. Select the components that you want to install.
Check the ViTrax Server Application checkbox to select
the server or check the ViTrax Client Application checkbox
to select the client.
If you want to be able to view and manage the server from
the same machine, check both the ViTrax Server
Application and ViTrax Client Application checkboxes.
11. Click Next to continue with the software installation.
12. Place a shortcut for this application in the Start Menu
Folder so that every time the host computer reboots, it
automatically restarts the AS-525AV ViTrax software.
This window allows you to select the Start menu folder.

Page 13
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Figure 5: Select Start Menu Window

13. To accept the default shortcut location, go to step 15..
14. To change the shortcut location, click Browse.
15. Click Next to continue with the installation.
The Select Additional Tasks window opens.

Figure 6: Select Additional Tasks Window

16. Select the relevant additional tasks, as required, and then
click Next to continue.

AS-525AV ViTrax Software Manual
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Figure 7: Ready to Install Window

All the installation settings are now entered. Installation can
now begin. Click Cancel to cancel the installation, or, click
Install to install AS-525AV ViTrax software.
When the Setup Completed window appears, the software
is successfully installed. By default, the Run server setup
wizard (recommended) checkbox appears checked. If
you do not want to launch the Server Setup Wizard at this
stage, clear the checkbox.
17. Click Finish to exit the installer.

2.3 Server Configuration
Before using the software, you must set up the server
configuration using the Server Setup Wizard and activate the
software.

To open the server configuration wizard:
1. In the last screen of the Rosslare Setup Wizard, make sure
the Run server setup wizard (recommended) checkbox is
checked. Click Finish.
Or
From the Start menu, select Rosslare  Tools  ViTrax
Server Setup Wizard.
The Server Setup wizard opens.
Page 15
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Figure 8: Server Setup Wizard Window

This wizard guides you through the initial server setup.
Before installing the server, you will be prompted to
activate the software.

2.3.1. Activate the Software
The software must be activated in order to use it and to ensure
proper support.
You can activate the software in the following ways:

Internet Activation
Internet activation is the quickest and most convenient way to
activate the software if the machine is connected to the
Internet.

Phone Activation
Phone Activation is the other option to choose if you are not
connected to the Internet and wish to activate the software.

No Activation
The No Activation option in the Activation Wizard uses the
demo version of AS-525AV ViTrax. This option limits use of the
software to Shareware use, which includes only basic features
and configuration capabilities.

AS-525AV ViTrax Software Manual
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To activate the software via Internet:
1. Start AS-525AV ViTrax software from the Windows Start
menu or click the AS-525AV ViTrax icon on the desktop.
2. When the Rosslare Activation Wizard opens, click Next to
continue the activation. The Product Activation Method
window opens.

Figure 9: Product Activation Method Window

3. If the machine is connected to the Internet, select Internet
Activation to activate the full version of the software.
4. Click Next to continue the activation.
The Activate Product over Internet window opens.

Figure 10: Activate Product over Internet Window
Page 17
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5. Enter the activation key that is found on the software disk.
Click Next to continue with the activation. The activation
finishes. The Activation Completion window displays the
description of the edition and the access limitations.
6. Click Finish to exit the activation wizard and continue
installing the server configuration.

To activate the software via Phone:
1. Follow steps 1 and 2 in the above activation process.
2. If the machine is not connected to the Internet, select
Phone Activation to activate the full version of the
software.
3. Click Next to continue the activation.
The Product Activation over the Phone window opens.

Figure 11: Activation Wizard Window

4. Type the Activation Key in Step 2 on the screen. You can
find the Activation Key on the software disk.
5. Provide the system ID that appears in this window to the
customer service representative on the phone.
6. Call a Rosslare representative at +972-3-938-6838 for the
Confirmation Key, and type it in Step 4 on the screen.
7. Click Next to complete the activation. The Activation
Completion window displays the description of the edition
and the access limitations.
8. Click Finish to exit the activation wizard and continue
installing the server configuration.
AS-525AV ViTrax Software Manual
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To select the No Activation option:
1. Follow steps 1 and 2 in the above activation process.
2. Once the Product Activation Method window opens,
select No Activation (continue using Shareware version).
3. Click Finish to exit the Activation Wizard and continue
installing the server configuration.

2.3.2. Server Setup
After activating the software, continue with the server
configuration setup.

To setup the server configuration:
1. Specify the server properties, such as unique identifier, title,
and database settings in the Server Properties window.

Figure 12: Server Properties Window

Enter the Server ID and Server Title. Choose the destination
location for the configuration database. Check the
Compact the configuration database checkbox to
optimize the configuration database in the future.
2. Click Next to continue the Server Setup Wizard. The Server
Administrator Settings window opens.

Page 19
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Figure 13: Server Administrator Settings Window

This window determines the settings for the Administrator.
Leave the default user name as admin and enter a unique
password in both lines. You can add users at a later time.
3. Click Next to continue with the Server Setup Wizard.
4. Determine the Server Network and Port Settings.

Figure 14: Server Network and Port Settings Window

The default firewall port that Rosslare uses is 60554. You can
change it to any port as long as it is open on the firewall.
Check with the network administrator or internet service
provider about the appropriate firewall settings.
5. Click Next to continue with the Server Setup wizard. The
Server Execution Mode window opens.
AS-525AV ViTrax Software Manual
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Figure 15: Server Execution Mode Window

This window has two options:
• Application mode — starts the program manually via
three options in the dropdown menu:
o Manual — double-click the program to get it started
o Automatic with any user logon — initiates the
software when any user logs into Windows on that
machine
o Automatically with current user logon — the user
currently logged into Windows is the user who
activates AS-525AV ViTrax upon Windows login
• Service Mode — the software always runs in the
background even though nobody has yet logged into
Windows. This means that you can lock everyone out of
Windows and never have to worry about any of the
data. Also, if the power ever goes out, upon power
recovery, the system turns on and nobody needs to
physically log into windows or turn AS-525AV ViTrax
software on in order to keep the data flowing both
locally and remotely.
Note:
The Service Mode is the recommended option.

If AS-525AV ViTrax software is set up in Service Mode it can
be stopped by browsing the windows services or by using
the ViTrax Server Setup Wizard (see Step 1 above).
Page 21
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6. Click Next to continue with the Server Setup wizard. The
Server Execution Control window opens.

Figure 16: Server Execution Control Window

The options shown here depend on the choice made in
the previous screen. Choose to either Start Server
Application or Start Server Service.
7. Click Next to continue with the Server Setup wizard.
8. When the Wizard Completed window appears, click Finish
to exit the installer. The ViTrax Server has been successfully
installed.

2.4 Adding the Server to the Client
Before using AS-525AV ViTrax software, you must add the server
information to the client application.

To add the server information:
1. Double-click the ViTrax Client connection icon located on
the desktop. The main screen is displayed.
Note:
A Warning dialog box appears, stating that there are
no video cameras found on the local server. If you
click Yes, the software scans for cameras using auto
detection (in the Network Scan Wizard). If you click
No, you can add the cameras manually (in the
Camera Setup Wizard).

2. From the Server menu, click Server and then Add Server.
AS-525AV ViTrax Software Manual
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3. When the Add New Server Wizard appears, click Next. The
Adding New Server window opens.

Figure 17: Adding New Server Window

The following data is added in this window:
• Server IP Address: The IP or the DNS of the server you
want to connect. If the server is on the same machine,
type localhost.
• Server Port: The port the server is running on.
• User Name: Enter the login username user name, by
default, Admin
• User Password: Enter the password associated with the
user
• Options:
o Remember password – If you choose to leave this
field unchecked, the server requests a password
every time you log on.
o Auto connect on start – Selecting this option auto
connects to the server as soon as you open the
Client.
o Auto reconnect on disconnection –Selecting this
option instructs the program to automatically
reconnect you in the event of disconnection.
• Server Title: Enter a name for the server.
4. To continue adding a server, click Next. The Wizard
Completed window opens. Click Finish.
5. Click File and then Save As.
Page 23
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6. Click the Desktop icon to select Desktop in the Save in line.
7. Find the ViTrax Client and highlight it so the name appears
in the Save in line.
8. When the program asks to override the client which
already exits, click Yes.
Note:

If you do not click Yes, the new server is not saved in
the server list on the left and you have to re-enter the
information when you reopen the program.

The client installation is now complete. You now have
video feed from the connected cameras.

AS-525AV ViTrax Software Manual
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3. System Overview
AS-525AV ViTrax is controlled through an easy-to-use interface
featuring:
• Tree-view list of all aspects of the site set-up
• Toolbar for standard operations

3.1 Initiating AS-525AV ViTrax
This section explains how to start the software and login to the
main window.
1. Before you start AS-525AV ViTrax software, you must first
turn on the server. Select from the Start menu  Programs
Rosslare  ViTrax Server or double-click the icon below
found on the Windows desktop.

Figure 18: ViTrax Desktop Icons

2. Once the server is connected, you can start AS-525AV
ViTrax software. Select from the Start menu  Programs 
Rosslare ViTrax Client or double-click the icon on the
Windows desktop.
3. The Authorization dialog box for the remote server opens.

Figure 19: Authorization Dialog Box

4. Type the password you chose in the Server Setup Wizard.
Click Logon to have access to AS-525AV ViTrax.
AS-525AV ViTrax Client main window opens.
Page 25
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3.2 AS-525AV ViTrax Main Window
All the central functionality of AS-525AV ViTrax is available from
its main window.








Figure 20: AS-525AV ViTrax Main Window

AS-525AV ViTrax is divided into six sections.
Note:

This screen is not the initial screen that appears upon
start-up. It is only used to better explain the system
overview.



Menu Bar

Access to the general operations and setup
of the system



Toolbar

Contains icons for key management tasks



Structure Pane Configure, monitor, and control client and



Display Pane

Displays the hierarchy of the selected
element



Events Pane

Lists the time and date record of serverclient connection



Status Bar

Displays general status information such as
system readiness and screen layout
sequence options.

server elements in the system

AS-525AV ViTrax Software Manual
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3.3 Menu Bar
Access to the general operation and setup of the system is
through the menu bar. It contains menu options such as the
file, view, server, video, tools, and help menus.

3.3.1. File
Manage the client files by clicking on tasks in the menu bar, by
pressing the shortcut keys on the keyboard, or by clicking the
related toolbar icons, when applicable.
New

Creates a new AS-525AV ViTrax client file with the
file extension of .lxd.
Access this task on the keyboard with shortcut key
Ctrl-N.
Opens previous AS-525AV ViTrax configuration files.
Open
The video stream of the selected file displays in the
Display Pane.
Access this task on the keyboard with shortcut key
Ctrl-O or by clicking the Open Configuration icon
on the toolbar. (See Toolbar, on page 38.)
Saves current client configuration file.
Save
Access this task on the keyboard with shortcut key
Ctrl+S or by clicking the Save Configuration icon on
the toolbar. (See Toolbar, on page 38.)
Saves the client configuration to a different file or
Save As
even to a floppy.
Recent Files Displays path of recently opened client files.
Closes AS-525AV ViTrax Client.
Exit

3.3.2. View
Select the items you want to see in AS-525AV ViTrax window
through the view menu bar options such as toolbars frequently
used and the preferred layout of the Viewing Pane.

Toolbars
Choose to view or hide the following toolbars:
• Standard —contains most commonly used tasks and
functions
• Screen Arrangement —manipulates the views and
camera layouts to the own preference
Page 27
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• Screen Control —manages video streams and camera
view choices in the Display Pane

Panes
Toggle between viewing and hiding the following panes in AS525AV ViTrax window:
Structure —the pane that is visible on the left side of AS-525AV ViTrax window. It is the control center of the system and is most useful when you are looking at
cameras from multiple locations and multiple AS-525AV ViTrax servers (see

• Structure Pane, on page 39).
• Events —the pane that is visible on the lower half of AS525AV ViTrax window. It gives the important
notifications such as when you are connecting to a
server successfully, lets you know if you have input
improper user names and passwords, and gives you
error codes when needed.
• PTZ Control —controls the PTZ tasks if you have a PTZ
compatible camera attached to the system.
• Video Adjustment —the pane that contains tools to
adjust every individual camera with its own settings (see
Making Video Adjustments, on page 87).

Status Bar
This bar displays general status information such as system
readiness and layout sequence options. Click the Manage
Layout Sequences icon
to access the Manage Layout
Sequence feature (see Creating Custom Layouts, on page 96)

Full Screen
In full screen, none of the panes are seen and the cameras
expand to their maximum size to fill the full screen of the
monitor.
Access this feature from the View menu, the F11 shortcut key
on the keyboard, or by clicking on the Full Screen icon on the
toolbar (see Toolbar, on page 38).
Minimize full screen view by pressing the F11 shortcut key on
the keyboard or by clicking Exit in the Full Screen dialog.

AS-525AV ViTrax Software Manual
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Figure 21: Full Screen Dialog

Always on Top
Enabling this feature prevents other application windows from
opening on top of AS-252 ViTrax Client windows until you
uncheck Always on Top.

Screen Arrangement
This feature allows you to manipulate the views and camera
layouts to your own preference.
Equal Size Screens
This feature displays the screens in the Display Pane in a
designated number of equal size screens.

Figure 22: Screen Arrangements
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Large Size Screens
This feature displays the screens in the Display Pane in a
designated number of equal size screens with 1-2 large
screens.

Figure 23: Large Screen Arrangements

Maintain Aspect Ratio
When enabled, this feature maintains the correct proportions
of the images appearing in the Display Pane screens.

Screen Details
Select the details you want to appear on each of the screens
in the Display View with the following preferences:
Show Screen Footer Displays footer under each screen in the
Display Pane. Access this task on the
keyboard with shortcut key Alt+Shift+O.

Show Current Frame Shows current frame time of the displayed
image in the screen footer of selected
Time
screens. Access this task on the keyboard
with shortcut key Alt+Shift+T.

Show Image
Resolution

Shows the resolution of the displayed
image in the screen footer of selected
screens. Access this task on the keyboard
with shortcut key Alt+Shift+R.

AS-525AV ViTrax Software Manual

Page 30

System Overview

Show Average
Image Size per
Frame

Shows the average image size per frame
of the displayed image in the screen
footer of selected screens. Access this task
on the keyboard with shortcut key
Alt+Shift+Z.

Show Average
Frame Rate per
Second

Shows the average frame rate per second
(fts) of the displayed image in the screen
footer of the selected screens. Access this
task on the keyboard with shortcut key
Alt+Shift+F.

Digital Pan-Tilt-Zoom This feature does not work in this version.
Show Detected
Motion

Shows motion detection of the displayed
image in the selected screen. Access this
task on the keyboard with shortcut key
Alt+Shift+M.

Hide Detected
Motion for All
Screens

Hides motion detection in all displayed
screens.

Time Presentation
Choose between the following time preferences:
• Local Time
• UTC Time (Coordinated Universal Time)
• Server Local Time

Save Current Layout
The Layouts feature group cameras from different AS-525AV
ViTrax servers/locations into groups for more efficient
monitoring and better management. You can select this
option to save the currently selected layout.
View and select the available layouts in the Structure Pane
tree-view. The selected view displays in the Display Pane (see
Creating Custom Layouts, on page 96).

Manage Layouts
This feature allows you to set the preferences of all layouts. Also
access this option by clicking the Manage Layouts icon in the
Structure Pane (see Creating Custom Layouts, on page 96).
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Deactivate Layout Sequences
This feature deactivates layout sequences.

Manage Layout Sequences…
When layouts are created, they can be used to create video
sequencing through the Manage Layout Sequences feature.
This feature can be used to define which layout is activated
upon startup. Also access this feature by clicking the Manage
Layout Sequence icon in the Structure Pane (see Creating
Custom Layouts, on page 96).

Manage Maps
This feature allows you to quickly and conveniently locate
cameras for viewing placed on Google Map™ and/or on the
own JPEG map (see Map Module Feature, on page 100).

3.3.3. Server
Manage the servers by clicking on Server in the menu bar or by
pressing the shortcut keys on the keyboard, when applicable.

Add Server
This menu option launches the Add Server Wizard (see Adding
the Server to the Client, on page 22).

Remove All Servers
This menu option removes all server connections.
Upon selection, the system asks you to confirm your choice to
remove the server connection.

Selected Servers
Manage the servers with the following options in the submenu:
Connect

Connects to a selected server

Reconnect

Reconnects to a selected server

Disconnect

Disconnects from a selected server

Refresh

Updates the server connection
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Tasks

Manages and configure server and camera options
with the following:
• Server Security Setup Wizard
• Manage Server Security
• Automatically discover network video devices
• Camera Setup Wizard (see Configuring Cameras, on
page 56)
• Video Frame Export Setup Wizard (see Exporting
Video, on page 108)
• Open Archive (see Playback Video, on page 106)
• Manage Watchdogs (see Server Configuration
under Server Watchdog, on page 47)
• Recording Properties (see Server Configuration under
Recording Properties, on page 42)
• TCP Communication Properties (see Server
Configuration under Server Communication
Properties, on page 45)
• Backup server’s archive data (see Archiving Backup
Wizard, on page 103)
• Find Network Cameras (see Network IP Cameras, on
page 73)
• Refer to the AC-525 Hardware manual to see a list of
compatible cameras.

Move Up

Scrolls up if you have multiple servers

Move Down Scrolls down if you have multiple servers
Remove

Removes server connection

Properties

Sets server preferences

Connect All Servers
This feature connects all servers on the system. Access this
feature on the keyboard with shortcut key Ctrl+Shift+C.

Disconnect All Servers
This feature disconnects all servers from the system. Access this
feature on the keyboard with shortcut key Ctrl+Shift+D.
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Manage Servers
Add, remove, configure, and connect or disconnect the
servers with this feature.

3.3.4. Video
The video menu options manage the video properties of the
images displayed in the Display Pane.

Stream
This feature enables you to pick which camera you want to
view in the selected camera window.

Transfer
This feature sets the video transfer rate, bandwidth controlled
broadcast time, motion control video transfer rate, and
recompression properties (see Enabling Video Transfer, on
page 94).

Digital-Pan-Tilt-Zoom
This feature enables you to select, drag, and zoom in/out of
the displayed PTZ camera image in Displayed View.
Also access this feature from Screen Details in the View menu
choice.
Enable

If selected, enables digital PTZ

Default Tool Changes the cursor to the default cursor
setting
Drag Tool

Changes the cursor allowing you to drag the
image in order to focus on a desired area

Zoom In
Tool

Changes the cursor allowing you to zoom in on
the image in order to focus on a desired area

Zoom Out
Tool

Changes the cursor allowing you to zoom out
of the zoomed image

Zoom Out
to Full
Frame

Zooms out back to the full image frame
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Show Detected Motion
This feature shows motion detection of the displayed image in
the selected screen in the Display Pane.
Also access this feature from Screen Details in the View menu
choice.

Properties
This feature shows camera properties of the screen selected in
the Display Pane.
AC-525 Properties
Shows the complete access control related properties
including Video, Time & Date, USB, and PTZ settings
Motion Detector Properties
Shows the motion detector properties (if the AC-525 has
motion detector enabled), including motion sensitivity, and
exclusion areas

Maximize
This feature toggles between current Display Pane view and an
enlarged view of a selected screen across the whole Display
Pane area.

Freeze
This feature freezes the video image of the selected camera,
allowing you to further inspect the frozen image.

Current Frame Subtitles
Allows you to define and show various subtitles associated with
the selected camera.
Enabled
Enables or Disables the subtitle feature for the selected
camera.
Properties
Allows you to define what will show in the subtitle as well as set
the word position on the screen and the font face, size and
color.
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Copy Current Frame to Clipboard
This feature allows you to copy currently rendered video frame
to Clipboard. Only the frame from a selected screen is copied.

Save Current Frame As…
This feature allows you to save currently rendered video frame
to a file. Only the frame from a selected screen is saved.
Also access this feature by clicking the Save Current Frame As
icon in the toolbar.

Un-map All Screens
This feature allows you to un-map the video stream from the
Display Pane. Also access this feature on the keyboard with
shortcut key Alt+Shift+U.

Automap Available Screens
This feature allows you to automatically map the video stream
to the available Display Pane. Also access this feature on the
keyboard with shortcut key Alt+Shift+A.

Automatically Show Video on Alert Event
This feature allows you to automatically map a networked IP
camera in order to get a video stream from the camera upon
an Alert event originating from the camera, see Figure 60:
Data Recording Window, Figure 62: Motion Control Tab and
the associated explanation there.
You can prevent video streams from being replaced by this
feature by locking the image on the layout view by pressing
the Push Pin Icon.

3.3.5. Tools
The Tools menu options manage password access security,
viewing files, and application options and preferences.

Lock Application
This feature locks the application until an exclusivity mode
password is provided to unlock it.
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When you click on Lock Application, you are prompted to
define a non-empty exclusivity mode password.

Utilities:
This feature opens and plays selected media files. You
navigate the Media File window by selecting the desired tool
from Navigation in the menu bar or by clicking on VCR
standard navigation icons in the Standard toolbar.
Open Media File
This feature allows you to open a previously saved video file
Camera Status Report
This feature opens a dialog allowing you to run a status report
on the various cameras connected to the system.

Options
This feature modifies settings for AS-525AV ViTrax such as screen
options, screen mapping, exclusivity, and other options (see
Setting System Options, on page 80).

3.3.6. Help
The Help menu options provide options to help you accomplish
various tasks.

ViTrax on the Web
This feature opens Rosslare website: www.Rosslaresecurity.com

Problem Report Wizard
This feature links you to a Problem Report wizard. The wizard
prompts you from screen to screen. The final report is sent to a
Rosslare service representative. This wizard can also be found
in windows program tree under Rosslare  ViTrax Tools.

About ViTrax Client
This feature lists product information such as product version
number, module version number, product activation key,
website address, and email address.
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3.4 Toolbar
The toolbar contains shortcuts to major menus and commands.
Click on each icon to transition to the desired section.

3.4.1. Standard Toolbar
Open Configuration—This button allows you to open previous
AS-525AV ViTrax configurations. It is most useful if you are
exporting configurations from one machine to another.
Save Configuration—This button allows you to save changes
made to the AC-525. It will continue to save into the same file
unless you click on File and Save As; then you can save to a
different file or even to an external memory, such as a USB 2.0
memory key.
Toggle Structure Pane— This button toggles between seeing
and not seeing the structure pane on the left side of AS-525AV
ViTrax window. Access this pane on the keyboard with
shortcut key Alt+Shift+S.
Toggle Events Pane—This button toggles the events window.
Access this pane on the keyboard with shortcut key
Alt+Shift+E.
Toggle PTZ Control Pane — This enables the Digital Pan-Tilt
Zoom option. PTZ compatible cameras are currently not
supported in this version of the software.
Toggle Video Amplification Pane— This button toggles the
video amplification pane. When this button is pressed, a pane
opens from which you can adjust the brightness, contrast,
saturation, sharpness, and hue for any camera.
Toggle Audio Player Pane— This button toggles the Audio
listening pane When this button is pressed, a pane opens from
which you can select an AC-525 platform and activate or
deactivate the audio feed
Togle Full Screen Mode — This button toggles full screen
mode. In full screen, none of the panes are seen and the
cameras expand to their maximum size to fill the full screen of
the monitor.
Open Archive — This button opens the archive viewer
window. You can view archived data of the connected
server.
Manage Maps — This button toggles map module window for
managing and viewing cameras on Google or previously
added maps.
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Save Current Frame as — This button allows you to save
currently rendered video frame into file. Only the frame from a
selected screen is saved.
Wizards — The wizards icon gives you a shortcut to various
server, camera options, and configurations. You can also
access these features through the right-click menus in the
software.

3.4.2. Screen Arrangement Toolbar
Views — These buttons allow you to
manipulate the views and camera
layouts to your own preference.

3.4.3. Screen Control Toolbar
Screen Footer — This button allows you to display a variety of
information beneath each camera window. It can display
frame rate, time, picture quality, recording, motion
detection, and image size. The screen footer is the text
below each camera.
Screen Stream Selection — This button allows you to pick
which camera you want to view in the selected camera
window. This can also be done through the right-click menus
and by dragging the desired camera from the structure
pane to the desired display window, or by right-clicking on
any camera window and selecting Stream.
Show Motion — This button toggles between showing the
motion outlined on the selected camera screen or not.
Motion detection must be set up before this feature can be
activated.
Maximize Screen — When pressed, this button puts the
selected camera into a single view. If pressed again it
returns to the previous view. This can also be accomplished
by double clicking on the camera of choice.

3.5 Structure Pane
The structure pane is the control center of the ViTrax AS-525.
You set up the AC-525, the cameras, and all third party servers
in the structure pane.
In the structure pane it is also possible for you to manage many
servers from one window by right-clicking on the server of the
choice.
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Figure 24: Structure Pane

Right-click the tree view to open the relevant options:
Console Root • Standard Toolbar
• Screen Arrangement Toolbar
• Screen Control Toolbar
• Structure Pane (toggles Structure pane view)
• Events Pane (toggles Events pane view)
• PTZ Control Pane
• Video Adjustment Pane (toggles between viewing
and hiding pane)
• Status Bar

Servers

• Add Server ( see Adding the Server to the Client
on page 22)
• Remove All Servers
• Connect All Servers
• Disconnect All Servers
• Sort Servers Alphabetically
• Manage Servers

Available
servers submenu

Right-click on the server name to view the
following options:
• Connect
• Reconnect
• Disconnect
• Refresh
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• Tasks: Server Security Setup Wizard, Manage Server
Security, Camera Setup Wizard, Video Frame
Export Setup Wizard, Open Archive, Manage
Watchdogs, Recording Properties, TCP
Communication Properties, Automatically discover
network video devices, Backup server's archive
data
• Remove
• Move Up
• Move Down
• Properties
• Video – Right-click to Open Camera Setup Wizard
• Archive – Right-click to Open Archive

Layouts

(See Creating
Custom
Layouts, on
page 96)

Right-click to view the following options:
• Save Current Layout
• Manage Layouts
• Deactivate Active Layout Sequence
• Manage Layout Sequences

3.6 Display Pane
The display pane shows all items within the structure pane
selected element.

Figure 25: Display Pane
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Right-click on any of the displayed views to enable features
such as:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Video Stream
Video Transfer
Point to Pan-Tilt-Zoom
Digital Pan-Tilt-Zoom
Show Detected Motion
Freeze
Current Frame Subtitles
Copy Current Frame to Clipboard
Save Current Frame As …
Open Archive …
Screen Arrangement
Maintain Aspect Ratio
AC-525 Properties
Motion Detector Properties

3.7 Events Pane
In this pane you can view a time and date record of serverclient connection.

3.8 Server Configuration
Now that you are a little more familiar with the software’s main
window, you are ready to configure the server.
In this section you learn how to check and modify:
•
•
•
•

Recording Properties
Server Communication Properties
Server Watchdog
Server User Management

3.8.1. Recording Properties
View and modify the hard drive space used by AS-525AV
ViTrax software.
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To display recording properties:
1. From the structure pane, right-click the server name.
2. Select Tasks  Recording Properties. The Recording
Properties dialog box opens.

Figure 26: Recording Properties Dialog Box – Directories Tab

The Directories tab displays the available hard drive space
and allows you to make modifications:
• Path – When you check and highlight either drive, the
Details option below becomes available for further
data entry. Do not check the drive C checkbox to
avoid using it for storage. If you only want a small
portion of the C drive to be used, define how much in
the Details option.
• Add – This button allows you to add external storage
addresses for recording such as sharing on the remote
computer or NAS drive.
• Remove – This button removes currently selected
network storage path.
• Path – Displays selected path.
• Priority –This option allows you to choose which of the
drives records first. You must first check and then
highlight (by clicking one time) the drive you want to
customize in this portion.
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• Quota – This option allows you to select the amount of
space you would like to designate for storage on that
particular hard drive. Never choose 100% for the C
drive. This may cause your machine to eventually crash
due to not enough available virtual memory.
3. Click Apply to save the settings.
4. Click the Duration Quota tab, which is used to set global
duration quota on all media devices and storage drives.

Figure 27: Recording Properties Dialog Box – Duration Quota Tab

5. Click the Statistics tab, which displays the used space and
available space left on the hard drives being used by AS525AV ViTrax software.
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Figure 28: Statistics Tab

6. Click View to enable Stored Streams by Source or Stored
Streams by Location.
7. Click Refresh at any time for an updated list.
8. Click Expand to view the Archive Total on a larger screen.
9. Click OK to save the settings and return to the Recording
Properties dialog box.

3.8.2. Server Communication Properties
View and modify who is connected to the server.

To open the server communication properties box:
1. From the structure pane, right-click on the server name.
2. Select Tasks  TCP Communication Properties. The TCP
Communication Properties dialog box opens.
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Figure 29: TCP Communication Properties – Server Tab

3. Click the Server tab to display the server status.
• Activate – This button allows remote users access server
over network using TCP protocol
• Deactivate – This button denies remote access to
currently connected users
• TCP Port – Default is 60554
• Save these settings as default – Check if you want the
new settings to be the default settings
4. Click Apply to save the settings.
5. Click the Connections tab to show who is connected to
your server. The IP address, user name, and connection
time can all be seen. Click Refresh at any time for an
updated list.
6. Click OK to save the settings and to close the window.
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Figure 30: TCP Communication Properties –Connections Tab

3.8.3. Server Watchdog
The server watchdog performs an important operation,
protecting the software from improperly working due to system
problems. Configuring the watchdog is not necessary if you
chose to enable it during installation. However, if you are
having frequent restarts or for maintenance adjusting, you may
choose to manually configure the watchdog.

To configure the watchdog:
1. From the structure pane, right-click on the server.
2. Select Tasks  Manage Watchdogs. The Watchdog
Management dialog box opens.
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Figure 31: Manage Watchdog Window

3. Highlight Software Watchdog by left clicking one time to
activate the Enable, Disable, and Properties buttons.
4. Click Properties. The Software Watchdog Properties dialog
box opens.

Figure 32: Watchdog Properties– State Tab

5. Click the State tab to stop or start running the watchdog.
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6. Under the Watchdog Options, you have the options to start
the watchdog with server and to enable the watchdog by
checking the checkboxes.
7. Click Apply to save the settings.
8. Click the Operation tab to configure the reboot action.

Figure 33: Watchdog Properties– Operation Tab

9. In the Operation tab, type the amount of time in seconds
for the grace interval, the amount of time for the Reboot
interval, and the number of failures before the device
reboots.
10. Click Apply to save the settings.
11. Click the Performance tab to configure which environment
performance counters and variables determine the
necessity of a server or system restart.
The watchdog attempts to restart the server or system after
exceeding any specified threshold.
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Figure 34: Watchdog Properties– Performance Tab

In the Performance tab, you select the following options by
checking them:
• Monitor system committed memory usage ratio
• Monitor system pool non-paged memory usage
• Monitor server private memory usage ratio
• Monitor server virtual memory usage
12. Click Apply to save the settings.
13. Click the Maintenance tab to set the restart.
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Figure 35: Software Watchdog Properties Window – Maintenance Tab

It is recommended you check the Enable periodic restart
checkbox. Enabling this feature restarts the Server
application at times specified. You can also define the
hours when the periodic restart will occur by checking the
Enable periodic restart _hours and set the time frame using
the text boxes to enter the desired hours.
14. Click OK to save the settings and to close the window.
Note:
It is recommended to restart the Server Application
to refresh system resources. The watchdog server
restart goes virtually unnoticed by the user.

3.8.4. Server User Management
Manage the server user permissions through the Server Security
Wizard. This wizard guides you step-by-step to add, remove, or
modify user permissions.

To access the server security wizard:
1. From the structure pane, right-click on the server.
2. Select Tasks  Server Security Setup Wizard. The Server
Security Setup Wizard dialog box opens.
3. Click Next.
The User Choice dialog box opens.
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Figure 36: Server Security Setup Wizard

4. Click Create a new user to create a new user.
5. Click Modify an existing user permissions to modify an
existing user permission.
6. Click Next to continue the setup. Make sure to be on the
user you want to use when you proceed.
The User Details window opens.

Figure 37: User Details Window

7. The User logon name (case sensitive) should display the
user for this setup wizard. Write a User password (Case
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sensitive) and rewrite it under Password confirmation. You
have the option to add comments or an E-mail address of
the user before continuing.
8. Click Next to proceed with the setup wizard. The System
Permission window opens.

Figure 38: System Permissions Window

9. Server administrators can grant or revoke certain
permissions on a camera-by-camera basis by checking the
Configure individual camera access permissions
checkbox.
10. Click Next to proceed to the next screen. The Device
Permissions window opens.
Note:
The following window, the Device Permissions
window, only appears if you check the Configure
individual camera access permissions checkbox.
Otherwise, it skips to the Action Summary window.
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Figure 39: Device Permissions Window

11. After reviewing the device permissions list, check the
devices in order to grant permission and uncheck the
devices in order to revoke permission.
12. Click Next to proceed to the next screen. The Action
Summary window opens.

Figure 40: Action Summary Window

13. This window allows you to review the requested action
details before you finish the setup wizard. Click Next to
continue.
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Note:

After you click Next in this window, you can no longer
click Back in the setup wizard. Be certain when you
review the Action Summary that it is all correct.

14. Click Finish to close the wizard or check Continue with
setting up other permissions to continue this setup wizard
for a different user.
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4. Configuring Cameras
You are now ready to set up the cameras. AS-525AV ViTrax
supports the AC-525 connection (in which you can connect
your cameras), and network (IP) cameras (web cameras).
This chapter explains how to set up the cameras and how to
configure each camera via the ViTrax Camera Setup Wizard in
order to record video from this camera and for motion
detection. The panel in the ViTrax software supports two
cameras.
The Camera Setup wizard helps you assign names for each
camera, adjust the cameras properties (like frame size, etc),
setup motion detector and event alert options and recording
settings.
AS-525AV ViTrax is compatible with the following cameras:
• AC-525 connection
• Network IP cameras and video servers
Note:

Refer to the AC-525 Hardware manual for details
regarding compatible cameras and for instructions
on the installation process of the AC-525.

4.1 Setting up AC-525 Connection
You are now ready to configure the AC-525 to work with AS525AV ViTrax. Each panel supports two cameras.

4.1.1. Configuring through the Camera Setup Wizard
This section explains how to configure each AC-525 to enable
video recording and for motion detection.

To configure the AC-525:
1. From the structure pane, right-click on the server.
2. Select Tasks  Camera Setup Wizard. The Camera Setup
Wizard dialog box opens.
3. Click Next.
The Camera choice dialog box appears.
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Figure 41: Camera Setup Wizard Window

4. From the first window in the wizard select either to either
add a new device or modify an existing one.
5. Click Next to continue to the next screen. The Camera
device properties window opens.

Figure 42: Camera Device Properties Window

6. In Device Title, type the name of device you are adding.
7. Click Properties to set device specific properties.

Page 57

AS-525AV ViTrax Software Manual

Configuring Cameras

Figure 43: Camera Setup – Properties – Location Tab

8. Click the Location tab to enter the AC-525’s IP address.
• Click Ping to ping the AC-525’s selected IP Address.
• Select Channel A or Channel B.
• Enter the required User Name in the User Name text box
• Enter the required Password in the Password text box
• Click Version to view the AC-525’s firmware version
• Click Reset to reset the AC-525’s video board, this
affects both channels A and B
• Click Add Channel to copy the settings to an additional
channel – this is used to add a second camera to the
panel.
• If the system is located behind a router, use the
advanced mapping, check the Use advanced port
mapping checkbox and fill all relevant information,
contact your network administrator for assistance with
the specific settings
Note:

It is strongly advised NOT to connect to the AC-525
web server application (see the AC-525 installation
manual) while the ViTrax server is connected to the
panel.

9. Click Apply to save the settings.
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10. Click the USB Storage tab to see the available USB storage.
In this tab you can also clear the USB association by
clicking on Clear USB.

Figure 44: Camera Setup – Properties –USB Storage Tab

11. Click the Time tab to set the panel’s time and date.
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Figure 45: Camera Setup – Properties – Time Tab

•
•
•
•

Use the Date select box to pick the correct date
Use the Time select box to pick the correct time
Select the time zone using the time zone select box
Enable or disable daylight savings by checking /
unchecking the Enable Daylight Savings Time checkbox
Note:

Daylight savings is not an automatic feature and
requires that you change it when applicable
manually.

12. Click Apply to save the settings.
13. Click the Video tab to set video resolution, video stream,
frame rate, and bit rate and to set the support of either
both cameras or only one of them, this setting depends on
the camera installation and requirements.
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Figure 46: Camera Setup – Properties – Video Tab

14. Click the Video Overlay tab to define texts, date and time
textual overlays and the way they appear on the video
footage.

Figure 47: Camera Setup – Properties – Video Overlay Tab
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15. Click the PTZ Settings tab to define the Pan Tilt Zoom
protocols, identification, and baud rate, use the advanced
port mapping if the system is behind a router.

Figure 48: Camera Setup – Properties – PTZ Settings Tab

16. Click the External PTZ Control tab to define built-in or
external PTZ control protocols.

Figure 49: Camera Setup – Properties – External PTZ Control Tab
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17. For external PTZ control protocols, click Properties… to
define the settings:
• In the General Tab:
o Set the PTZ protocol using the list of protocols
provided in the Protocol select box
o Define the communication settings including the
serial port, port speed, and device identifier.

Figure 50: External PTZ Control Properties – General Tab

Note:

For AC-525 integration, the communication protocol
must be set to “Pelco D” and the device identifier
must be set to “1”.

• In the Settings Tab:
o Activate the auto tracker function using the On /
Off buttons
o Activate backlight compensation feature using the
On / Off buttons
o Activate the Electronic Shutter feature using the On /
Off buttons
o Activate the automatic white balance feature using
the On / Off buttons
o You can also access the camera’s menu as well as
reset the settings back to factory defaults
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Figure 51: External PTZ Control Properties – Settings Tab

• In the Scheduler Tab:
o Activate the scheduler feature to automatically turn
the tracking feature on and off
o Schedule the times for activation and deactivation
of the Tracker On and Tracker Off features

Figure 52: External PTZ Control Properties – Scheduler Tab
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18. Click Apply and then OK to save the settings and return to
the Camera device properties box.
19. Click Next to continue with the Camera Setup Wizard. The
Video compression window opens.
Note:

Video compression setting is optional and can also
be accessed from the video transfer window, see
Enabling Video Transfer, on page 94.

Figure 53: Video Compression Window

This option allows you to compress video data. Disable or
enable server side compression.
After selecting a Compression handler from the dropdown
menu, click Properties. The JPEF Compressor Properties
window opens.
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Figure 54: JPEG Compressor Properties

20. Drag the handle on the Quality slider either left or right to
adjust the quality of the JPEG compression.
Click OK to return to the Video compression window.
21. Click Next. The Motion analysis window opens.

Figure 55: Motion Analysis Window

If motion analysis is required, check Use motion detector for
stream being set up.
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Then click Properties to make the desired settings. The
Properties window opens.

Figure 56: Sensitivity Tab

22. Click the Sensitivity tab to adjust the motion detection
sensitivity.

Figure 57: Exclusion Tab

23. Click the Exclusion tab and select which cells you want
excluded from motion detection.
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Figure 58: Format Tab

24. Click the Format tab to select desired resolution, motion
smoothing, and motion in each cell of a frame.
Note:
The higher the motion detection frame rate, the
slower the CPU processing.

Figure 59: Source Tab

25. Click the Source tab to select the source of motion
detection information and software motion detection
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analysis. Click OK to save the settings and return to the
Motion analysis window.
26. Click Next. The Data recording window opens.

Figure 60: Data Recording Window

This screen allows you to set up data recording properties.
Check Audio data and / or Video data and click
Advanced properties for advanced video data properties.
Note:
Audio data is separated from the video, enabling the
audio data will save audio data at all times, even
with no video data recorded. This requires additional
storage space.
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Figure 61: Time Lapse Tab

27. Click the Time Lapse tab. Check Enable time lapse
recording if you want to record fames with unconditionally
restrained recording frame rate.
Enter the desired frame rate per second (fps).

Figure 62: Motion Control Tab
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28. Click the Motion Control tab to not record frames with no
motion detected. Check Enable motion controlled
recording and enter the desired settings.
Click OK to save the settings and return to the Data
recording window.
29. To change the global recording properties:
Note:

The Global setting should not be changed every time
a camera is being set up.
These options are normally determined when setting
up a new server. Changes done here will affect all
the cameras and devices defined in the system.

• Click Global Recording Properties… button, see Figure
60, on page 69.

Figure 63: Directories Tab

• Click the Directories tab to select the desired network
path to use as external storage.
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Figure 64: Statistics Tab

• Click the Statistics tab to view the archive total.
o Click View to select viewing the stored streams by
source or location.
o Click Refresh to refresh the screen.
o Click Expand to maximize the size of the window.
o Click OK to save the settings and return to the Data
recording window.
30. Click Next. The Action summary window opens.

Figure 65: Action Summary Window
AS-525AV ViTrax Software Manual

Page 72

Configuring Cameras

This screen displays the selected settings. This is the last
opportunity to change the settings.
Click Back to change the settings.
31. Click Next to complete the Camera Setup Wizard.
32. When the Wizard Completion window opens, click Cancel
to exit the Camera Setup Wizard if you do not want to
preserve any of the settings
Or
Click Finish to exit the Camera Setup Wizard or check
Continue with setting up another camera to continue this
setup wizard for a different camera.

4.2 Network IP Cameras
A network IP camera is a digital camera that can be directly
connected to the Internet using cables or WiFi connection.
Network (IP) camera installations are highly scalable and
upgradeable. There is no need to buy and install additional
video capture boards for the AC-525 system in the event you
want to add a camera or increase performance of the system.
There are two ways of setting up a network IP camera to work
with the AS-525AV ViTrax:
• Let the software find the cameras automatically
• Manually input all of the camera’s IP information

4.2.1. Configure the IP Cameras Automatically
Configuring the IP camera automatically using the step-bystep Network Scan Wizard, is the most reliable and convenient
way to configure the IP camera.

To configure the IP camera automatically:
1. From the structure pane, right-click on the server.
2. Select Tasks  Automatically discover network video
devices… The Network Scan Wizard dialog box opens.
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Figure 66: Automatic Discovery Wizard - Network Scan Addresses

3. Select Scan network adapter address range and check the
available network adapter(s).
Or
If you know the networks IP range, search by the Scan IP
address range option for the cameras.
4. Click Next to continue setting up the IP camera. The
Network Scan Ports window opens.

Figure 67: Automatic Discovery Wizard - Network Scan Ports

5. Set the TCP ports that may be in use with IP cameras. Click
Next to continue. The Network Scan Credentials window
opens.
AS-525AV ViTrax Software Manual

Page 74

Configuring Cameras

Figure 68: Automatic Discovery Wizard - Network Scan Credentials

6. Provide authorization credentials, User Name and
password separated by a comma, to access password
protected network IP’s.
7. Click Next to begin the network scan. Once the scan is
complete the Preview Devices window opens. Select the
desired camera and Click Next. You can also access the
camera IP properties, which includes the camera name,
model and make and channel definition, by clicking the
Properties button.

Figure 69: Automatic Discovery Wizard – Discovery Process
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Figure 70: Automatic Discovery Wizard – Preview Devices

8. The Configured devices window opens, click Properties to
access the detailed attributes of the camera.
Click Next to continue. For more on the specific camera
properties contact your camera manufacturer.
Note:
The property window differs between different
cameras.

9. The Wizard completed window opens. Click Finish to finish
the installation and setup and exit the wizard..

4.2.2. Configure the IP Cameras Manually
Through the Camera Setup wizard, you can add and
configure the IP cameras manually.

To configure the IP camera manually:
1. From the structure pane, right-click on the server.
2. Select Tasks  Camera Setup Wizard. The Camera Setup
Wizard dialog box opens.
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Figure 71: Camera Setup Wizard Window

3. From the first window in the wizard under Add New Devices
select Network Devices (IP Camera, Video Server).
4. Click Next to continue to the next screen. The Camera
device properties screen opens.

Figure 72: Camera Setup Wizard

5. In Device Title, type the name of the name of the camera
you are adding.
6. Click Properties to set device specific properties.
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Figure 73: Device Properties

7. From the Manufacturer list select the Camera’s
manufacturer and then the corresponding model in the
Model list. Click OK, the detailed properties window opens.
8. Enter the devices access information and all other relevant
properties and settings. For more on the specific camera
properties contact your camera manufacturer.
Note:
The property window differs between different
cameras.
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Figure 74: Detailed Device Properties

9. Click Apply to save your settings.
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5. Setting System Options
You can modify the system's options for AS-525AV ViTrax such
as the screen options, screen mapping, miscellaneous,
exclusivity, and sound options.

To set system options:
1. From the File menu bar, click Tools  Options. The Options
window opens.

Figure 75: Screen Tab

5.1.1. Screen Tab
1. With the Screen tab selected, select the following screen
options:
Video renderer version
• Default (DirectX 7)
• DirectX 9
• DirectX7
• Legacy DirectX
• GDI

Preferred Screen Size

50%, 100%, 200%

Resolution
abbreviations

• Abbreviate when possible

AS-525AV ViTrax Software Manual

• Don’t abbreviate
Page 80

Setting System Options

Downsample large
images

• Default
• Disabled
• Enabled, Favor Quality
• Enabled, Favor Speed

2. Click the Screen Mapping tab to define camera to screen
mapping.

Figure 76: Screen Mapping Tab

5.1.2. Screen Mapping Tab
1. With the Screen Mapping tab selected, select the following
screen options:
Automatic Mapping
• Automatic – camera is mapped to
screen automatically
mode
• Disabled

Save Last Mapping
Mode

• Per Arrangement
• Automatic
• Disabled

Pause live data while
archive window is
opened
Page 81
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2. Click the Miscellaneous tab to set application options and
structure pane options.

Figure 77: Miscellaneous Tab

5.1.3. Miscellaneous Tab
1. With the Miscellaneous tab selected, select the following
screen options:
Startup window mode
• Normal Window
• Always Full Screen

Expand items on
population

• None
• Server
• Server and Category

Server double-click
action

• Connect to Server
• Show Properties

2. Click the Exclusivity tab to set exclusivity rights, passwords,
and startup options.
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Figure 78: Exclusivity Tab

AS-525AV ViTrax includes safety features that prevent
human error by allowing access to AS-525AV ViTrax. These
features include:
• Exclusivity Mode (Windows lock out feature)
• Lock Application

5.1.4. Exclusivity Tab
1. With the Exclusivity tab selected, select the following
screen options:
Password
• Type in any password
• Check whether you want to Request comfirmation
before lock.
• As you type in the password, the Startup Lock will
not be grayed out.

Enable
exclusive
mode
Startup

By enabling the exclusive mode, you can only use
the computer for surveillance purposes and
cannot use the internet or other programs.
• Manual start
• Automatic with any user logon
• Automatic with current user logon
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Startup
Lock

• Start unlocked
• Start locked

The exclusivity mode is a safety feature that prevents the user
from having access to Windows operating system. Enabling this
feature allows the user access to AS-525AV ViTrax software
only. This ensures uninterrupted server operation and stability,
eliminating human error. See Lock Application, below.

5.1.5. Sounds Tab
Under the Sounds tab, you are able to set the sound .wav files
that will indicate the following events:
• Disconnection from Server (Failure)
• Video Source Motion
• Disconnection from Server (Success)
• Connection to Server
You can browse your computer or the internet to add such
.wav files.
Make sure to click Apply if you have made any changes to the
system's options. To exit at any point, click Cancel.

5.2 Lock Application
AS-525AV ViTrax Client can be locked to ensure that no one
has access to server settings except the administrator. The
exclusivity mode password is used to unlock the application.

To enable lock application:
1. From the File menu, click Tools  Lock Application. The
lock application is now enabled.
Note:
A warning window appears when you click Lock
Application and says "The application will be locked
until exclusivity mode password is provided to unlock.
Would you like to unlock now?"

The following prompt screen appears.

Figure 79: Password Prompt
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2. Type in the same password you already chose in the
Exclusivity tab. See Exclusivity Tab, on page 83.
Note:

The unlock password prompt window appears and
becomes semi-transparent or hidden while the
keyboard input is idle. Everything on the screen will
be grayed out so that no one can use the computer
while you are not present. Start typing the password
and the password prompt window reappears on the
screen.

3. Click the Sounds tab to attach sound files to specific
events.

Figure 80: Sounds Tab
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6. AS-525AV ViTrax Video Capabilities
Now that the software is installed and the cameras have been
configured, you are ready to learn about some of the
software’s capabilities.
In this chapter, the following features are explained:
•
•
•
•
•
•
•
•
•

Making Video Adjustments
Exporting Video Frames
Enabling Video Transfer
Creating Custom Layouts
Map Module Feature
Archiving Integrity Wizard
Archiving Backup Wizard
Playback Video
Exporting Video

6.1 Making Video Adjustments
Adjust every individual camera with its own settings through
the video adjustment feature. The following settings can be
adjusted: Brightness, Contrast, Saturation, Sharpness, and Hue

To make video adjustments:
1. Click the Video Amplification icon on the toolbar.

Figure 81: Video Amplification Icon

The Video Adjustment screen opens.

Figure 82: Video Adjustment Screen

2. Slide the handles left or right to adjust the settings
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6.2 Exporting Video Frames
The Video Frame Export Setup Wizard allows you to configure
continuous saving of video frames on network, fixed storage, or
an FTP. Frame exports can be configured for multiple devices.
Exported frames are saved in JPEG format using the filename
format you specify when configuring the export until disabled.

To run the Video Frame Export Setup Wizard:
1. Right-click on the appropriate server in the structure pane.
Or, Select menu item ServerSelected Server.
2. Click Tasks.
3. In the submenu, click Video Frame Export Setup Wizard.
4. When the Welcome to the Video Frame Export Setup
Wizard opens.

Figure 83: Export Setup Wizard - Video Streams Welcome Window

5. Select one or more devices and click Next to continue. The
Video Streams Export properties window opens.
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Figure 84: Export Setup Wizard – Export Properties Window

6. Select each of the devices and enable or disable the
video frame export.
If you want to enable export, click Properties to configure
the various properties. The Export Properties window
opens.

Figure 85: Export Setup Wizard – Properties Popup – File Tab

7. Select an export profile from the list or click Manage… to
create or edit a profile. Select a file naming template from
AS-525AV ViTrax Software Manual
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the list of file name templates. See ahead Specify Transfer
Defaults for Newly Added Devices, on page 96 for detailed
explanation. Click the Format tab.

Figure 86: Export Setup Wizard – Properties Popup – Format Tab

8. Check the Effects checkbox to enable video resizing, click
the Resampling Properties button to define the resizing
properties of the exported video.
Select the compression handler from the list and click the
Compression Properties… button to define the level of
video compression.
Click the Time Lapse Tab.
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Figure 87: Export Setup Wizard – Properties Popup – Time Lapse Tab

9. Enable Time lapse processing to lower CPU load, set the
frame rate, (frames per second). Click the Motion and
Events Tab.

Figure 88: Export Setup Wizard – Properties Popup – Motion and
Events Tab
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10. Enable or disable Motion and Event controlled video
processing (appears if supported by camera). Click Apply
to save your settings. Click OK to return to the Video
Streams Export properties window.
11. After you have configured the profiles, continue with the
wizard installation. (See Complete the Video Frame Export
Setup Wizard, on page 94.)

6.2.1. Configure Profile Properties
The Profile Properties allows you to configure the profile settings
to export the video frames.
There are two types of profiles:
• File export—prepares the video frames for export to a
file
• FTP export —prepares the video frames for export to an
FTP site
There are four tabs in the Properties window:
File
Format
Time
Lapse
Motion
and Event
Control

Page 91

Select a profile from available list or configure a new
profile using the Manage button
Configure the video effects and compression options.
Process frames while constraining the frame rate.
Enable the time lapse to lower the CPU load and leave
more CPU time for other tasks.
Motion Control provides an opportunity to process data
for when motion is detected or an event occurred.
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Figure 89: Export Properties Window

1. In the Profile area, select an already created profile or
create at least one to start using video frame export.
2. In the File Name Template area, select a name from the
dropdown menu or choose another name.
Each frame is saved in a file with a template string used for
formatting the filename.
Note:
Make sure the filename is unique by adding it's time
in ms or random unique string ($(Ms) or $(Unique)
format tags).

3. Click the Manage button to create, edit, or delete profiles
used to export video frames.
Note:
Reconfiguration of a profile affects all video streams
the profile is selected for.

The Profiles Property window opens.
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Figure 90: Profiles Properties Window

In the Profile Title area, you can edit or delete already
created profiles.
4. Click Create to open the dropdown menu displaying the
export video frames location choice. Choose from the
following:
• File Export Profile
• FTP Server Profile

File Export Profile
The File Export Profile allows you to export the video frame to a
file or directory.
1. Click File Export Profile.
2. When the Write to File window opens, specify the desired
frame export directory, network storage, or share path in
Directory or Browse for the relevant directory.
Note:
If you are connected remotely, it is important to
remember that this is the server side directory.

3. Click OK to save the settings and return to the Profiles
Properties window.

Page 93

AS-525AV ViTrax Software Manual

AS-525AV ViTrax Video Capabilities

FTP Server Export Profile
The FTP Server Export Profile allows you to export the video
frames to an FTP site.
1. Click FTP Server Export Profile.
2. When the FTP Server Export Profile window opens, fill in the
appropriate settings to allow Rosslare to connect and save
frames here.
3. Click OK to save the settings and return to the Profiles
Properties window.

6.2.2. Complete the Video Frame Export Setup Wizard
1. Click Next to continue the installation. The Action Summary
window opens.
This page of the Video Frame Export Setup Wizard gives
you a summary of all of the changes that you have made
throughout the wizard.
2. Click Next to continue the installation. The Wizard
Complete window opens.
Congratulations, you have now setup export of frames for
the camera(s).
3. Click Finish to end the Video Frame Export Setup Wizard.

6.3 Enabling Video Transfer
The video transfer feature allows you to reduce network traffic
between AS-525AV ViTrax Server and AS-525AV ViTrax Client (if
remotely connected) and/or to decrease CPU load on the
client side. Video transfer reduces the amount of data
transferred from server to client by skipping some frames,
transferring only motion detected frames, and recompressing
or down sampling them without reducing recorded data
quantity and quality. This feature is useful in slow remote
connections or highly loaded networks when viewing cameras
remotely. It effectively decreases image resolution or transfer
fps on low-end systems, where AS-525AV ViTrax client is used
for viewing large numbers of cameras. This approach reduces
resolution and number of frames, waiting to be rendered on
the screens.
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To enable video transfer feature:
1. From the File menu, click Video  Transfer.
The Video Transfer Properties window opens.

Figure 91: Video Transfer Properties Window

2. In the Time Lapse & Bandwidth Control area, only check
Enable time lapse broadcast checkbox on the remote
connection if needed.
3. Check Enable bandwidth controlled broadcast if needed
to adjust data controlled broadcast.
4. In the Motion Controlled Broadcast area, check Enable
motion controlled video transfer remotely if you want to see
video on motion only.
This is very helpful because frame rate is distributed to the
cameras that have motion only.
5. Check Enable video transfer recompression.
Note:
Video transfer recompression is useful for remote
connections only.

AS-525AV ViTrax can usually record up to three mega pixel
images. This feature allows the user to increase the frame
rate with less image quality without changing the server
properties.
6. Click OK to save the settings.
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6.3.1. Specify Transfer Defaults for Newly Added Devices
Specify default values of the transfer defaults for newly added
devices. All options are identical to the Video Transfer
properties.

To specify transfer defaults:
1. Right-click on the server in the structure pane.
2. Click Properties. The Properties window opens.
3. Click the Video Transfer Defaults tab.

Figure 92: Video Transfer Defaults Tab

4. Set the desired properties in the following areas:
• Time Lapse
• Bandwidth Control
• Motion Control
5. After selecting the settings, click OK.

6.4 Creating Custom Layouts
Create custom layouts by grouping cameras from different AS525AV ViTrax servers/locations into groups for more efficient
monitoring and better management. For example, you can
group together all out-door cameras from different location or
all POS cameras from all registers.
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Note:

By default, empty screens are filled with available
cameras. You can disable the automatic mapping
mode feature through the Screen mapping tab in
Options.

To create custom layouts:
1. Right-click on Layouts in the structure pane.

Figure 93: Layouts

2. There are four options in the dropdown menu:
• Save Current Layout
• Manage Layouts
• Deactivate Active Layout Sequence
• Manage Layout Sequences

6.4.1. Save Current Layout
View and select the current layout in the Structure Pane treeview. The selected view opens in the Display Pane.

To save current layout:
1. Click View  Select the Save Current Layout. The Layouts
window opens.
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Figure 94: Layout List Window

2. Modify the current layout by selecting the Current Layout in
the Name box and use the following buttons to modify:
• Rename – Renames current layout
• Set Startup – Program opens with this layout when
starting up
• Delete – Deletes current layout
• Activate –Activates current layout

6.4.2. Create New Layout Sequence
When layouts are created, they can be used for sequencing.

To create sequences:
1. Right-click on Layout.
2. Click Manage Layout Sequences from the submenu.
The Layout Sequences window opens.
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Figure 95: Layout Sequences Window

3. Click New to create a new sequence. The Layout
Sequence Properties window opens.

Figure 96: Schedule Window

4. Click the Schedule tab.
5. Click Add or Remove to add or remove sequences.
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6. Click Move Up or Move Down to manage priority or remove
layouts of the choice.
7. In the Layout area, choose existing layouts from the
dropdown menu to add to a sequence.
8. In Pause, set the time interval between layouts.
9. After completing the desired settings, click OK.

6.5 Map Module Feature
The map module feature allows you to quickly and
conveniently locate cameras for viewing placed on Google
Map and/or on the own floor plans added in JPEG format.

To start the map module feature:
1. Click the map icon on the toolbar.
AS-525AV ViTrax Maps window opens.

Figure 97: AS-525AV Maps Window

Use the navigational tools to navigate around the map.
Pan up, pan down
,
,

Pan left, pan right
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Return to the last result
Zoom in, Zoom out slider

Use the view buttons on the map to display different views
of the map:
Shows a street map
Map
Shows satellite imagery
Satellite
Shows satellite imagery with street names
Hybrid
2. Right-click on the map and use context menu commands
to configure and control map features.

Figure 98: Context Menu Commands

Add New Camera Marker

Goto Map
Create New Map From File
Fit To Window
Page 101

This option adds a camera
marker in designated menu
(See Add New Camera Marker,
on page 102)
Navigate to other maps in
appeared list
Add new map from JPEG
image file to be used as
background
The JPEG map strains on the
window while maintaining its
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Save Current Position
Set Current Map As Startup
Rename Current Map
Remove Current Map

aspect ratio
Used in Google map to save its
current position
Sets current map as startup
map. Selected map loads
when viewing this map module
Rename currently selected
map
Delete currently selected map

6.5.1. Add New Camera Marker
1. After choosing this menu option, select from a list of servers
and cameras.
2. After adding new marker, double click on the marker to
activate the matching camera.

Figure 99: Add New Camera Marker

3. To remove the marker, right-click on the marker and
choose according to popup menu item.
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6.6 Archiving Backup Wizard
The purpose of the Archive Backup wizard is to backup
specific parts of the archive or burn CD/DVD with the archive
and Archive Viewer on it. This can be useful to create backup
copies of the archive with lower fps, or writing specific part of
the archive on the CD for other machines without AS-525AV
ViTrax installed on them.
Note:

This wizard works only on the same machine AS525AV ViTrax server is installed.

To run the Archive Integrity wizard:
1. From the structure pane, right-click the server name.
2. Select Tasks  Backup Server’s archive data. The ViTrax
Server Archive Backup Wizard opens. When the
Introduction to the Archive Backup Wizard opens, click
Next to continue the Archive Backup wizard. The Select
cameras to backup window opens.

Figure 100: Select Cameras to Backup Window

1. Select one or more cameras you want to backup from the
list. The original file size is shown; the estimated archive size
appears on every page of this wizard.
Note:
You can decrease the estimate size by deselecting
some of the cameras, changing the time range. Or
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decreasing fps (frames per second) of archives
already backed up.

2. Click Next to continue the wizard. The Time Selection
screen opens.

Figure 101: Time Selection Window

3. Enter a start and stop time to change the time range. You
can also set data split (when recording to a CD, by either
Time or Stream. Click Next to continue.

Figure 102: Advanced Backup Options
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4. Check the Constrain backup video frame rate and enter a
number smaller than the displayed number to decrease
the frame rate thus reducing file size.
5. Click Next to continue the wizard. The Backup Destination
window opens.

Figure 103: Backup destination Window

6. Select backup type by clicking Copy archive onto hard or
network drive. In Location, enter the desired location to
store backup or Browse to select a location. Click Next to
begin archiving.
Or
Click Write on CD/DVD and click Next to set CD/DVD
burning options.
• Select the interface used for CD/DVD burning, this can
be either Nero Burning ROM (requires NERO to be
installed) or IMAPI.
• Select the CD/DVD drive, you can also browse for the
device.
• Select ejection behavior.
• Click Next to begin burning process.
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Figure 104: Advanced CD/DVD Burning Options Window

7. Click Next to continue to the Backup wizard finish screen.

6.7 Playback Video
Playback the recorder videos with the playback feature.

To playback the recorder video:
1. Right-click on the server name in the structure pane.
2. Select Tasks  Open archive Or Right-click on any camera
view and select Open archive. The Archive window opens.

Figure 105: Playback Screen
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6.7.1. Understand the Playback Screen
Now that you are in the playback screen, the structure pane
on the left lists all of the cameras that you have recordings for.
Double click on the camera for playback. This camera now
appears with footage on the video screen.
The Playback screen contains the following:
Color coded time line

The solid green line on the bottom
represents time. The light green lines
represent recorded video. The orange
lines represent motion information and
light blue represents Audio.

VCR basic controls

There are basic VCR controls on the
bottom of the playback screen, which
you can use to play, pause, forward, and
rewind.

Job dial

You can drag in either direction to
browse through the video in high speeds.

Fast forward arrow
controls

Use the arrow controls on top of the
screen to define how many increments of
time you would like to move through the
video or select from the dropdown menu:
• 1 Second
• 10 Seconds
• 1 Minute
• 10 Minutes
• 1 Hour

Use these previous motion or seek next
motion buttons to seek video with actual
motion in order to save time
You can search the screen through video
Smart search
and also by motion in a specific part of
the camera screen
You can define a specific object in the
view, or define a path, and seek through
motion only in that specific region.
Define motion of interest Select a specific area on the screen to
define motion (See below)

Playback motion
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To define motion of interest:
1. From the menu bar click Navigation  Define Region of
Motion Interest. The Region of Motion toolbox opens.

Figure 106: Region of Motion Interest Toolbox

2. Click the Seek to previous motion or seek to next motion
icons to search through motion in the defined area(s).

6.8 Exporting Video
Use the Export wizard to export video. To prevent the section of
recordings you want to export from being overwritten, first
select a different location for the recordings you want to
export before running this wizard.

To run the Export wizard:
1. Click Edit on the playback screen.
2. Click Export Wizard.
Following the Welcome screen, the Archive Export – User
Interface (GUI) Complexity window opens.
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Figure 107: Archive Export – User Interface (GUI) Complexity window

3. Select either Simple mode or Advanced Mode to
determine the level of complexity in your setup choices.
Click Next to proceed. The Archive Export – Export Type
window opens.

Figure 108: Archive Export – Export Type window

4. Select the output file type between Avi, Jpg, or asf / WMF.
Click Next to proceed. The Archive Export – Video Stream
window opens.
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Figure 109: Archive Export – Video Stream Window

Figure 110: Archive Export – Video Stream Window – Advanced

5. Select the camera you want to export video from the
Video Stream dropdown menu.
6. Select one of the compression options from the Format
dropdown menu, if you selected the Advanced option in
step 3, click Properties… to fine tune your format
compression.
7. Select the video stream resolution from the Resolution
dropdown menu.
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8. Select the Subtitle file type from the Subtitles dropdown
menu.
Click Properties… to define the subtitle’s font parameters.
If you selected the Advanced option in step 3 you have
the option of creating subtitles in a separate file rather than
integrated into the video, in such a case, select the
external file format from the Soft Subtitles Format dropdown
menu.
Click Next to proceed. The Archive Export – Export Options
window opens.

Figure 111: Archive Export – Export Options Window

9. Narrow down the time frame of the video stream to be
exported using the Start and Stop Time options.
10. To adjust the output frame rate, check the Adjust Exported
Video rate, and either enter the value or use the frame rate
slider.
Click Next to start exporting the video stream based on
your selection.
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Figure 112: Archive Export – Export Progress Window

6.8.1. Export Snapshots
Another way to save images is by creating screen captures, or
snapshots, one frame at a time.

To export snapshots:
1. in the live view Right-click the stream you wish to create a
snapshot of and select Save Current Frame As… the same
option can be accessed from the Video command in the
menu bar, alternatively, use the keyboard shortcut
Ctrl+Shift+S. In the review screen the option can only be
reached from the video menu or using the keyboard
shortcut.
2. Select a location and filename for the image.
3. Choose the file type you wish to save, Jpeg or Bitmap
4. Click Save.
Now you have the image stored in order to print, e-mail, or
enhance that snapshot.
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7. Upgrading AS-525AV ViTrax Software
To check for upgrades and new versions contact Rosslare
Technical Support, or visit the Rosslare support site for
information on new version releases.
Updating the software requires all AS-525AV ViTrax services to
stop before Installation.
During the installation of the new version you may encounter a
message with regards to previous installation configurations, if
applicable. Specifically, would you like to use existing
database?
1. Click Yes to keep all current configurations of the server.
This is the recommended option.
or
2. Click No to start a new database. All previous settings and
configurations are erased and a new database is created.
Continue with the installation (see Installing AS-525AV ViTrax
PC Software on Page 10.)
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Appendix A. Additional Utilities
A.1. Authentication Validator
The watermark authentication validator utility, checks the
video file to verify authenticity, ensuring that the images are
identical to the ones exported from the ViTrax software and
were not manipulated or modified using various editing
applications.

To run the Watermark Validator:
1. From the Start menu, select Rosslare  ViTrax  Tools 
ViTrax Server watermark Validor. The Watermark Validator
utility opens.

Figure 113: Watermark Validator Wizard

2. Drag one or more video or screen capture files into the
Watermark Validator screen.
3. The utility will begin testing the file(S), once complete, a list
of all the files dragged will appear in the list showing the file
name, and status, including the number of frames in the file
and if different how many frames are different.

Figure 114: Watermark Validator Wizard result
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A.2. Camera Status Report Utility
The ViTrax comes with a utility that checks the various cameras
associated with the server defined in the software.
The complete report opens as an HTML file in your web browser
which you can then save for your convenience.

To run the camera status report utility:
1. From the Start menu, select Rosslare  ViTrax  Tools 
ViTrax Server Camera Status report.
Or
From within the ViTrax software, select Tools  Utilities 
Camera Status report.
The camera status report utility window opens.

Figure 115: Camera Status Report Utility Window

2. Select one or more available servers from the list.
3. Click Check  Start to launch the test.
4. Once completed a full report will automatically open in
your Web Browser.
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Appendix B. Detailed Computer
Specifications
The tables below provide detailed specifications based on
server and client settings.

B.1. ViTrax Server Computer Specifications Minimum
Requirements
MPEG4 compression, motion detection disabled

No. of Cameras

CPU

Speed

RAM

Personal (1 cam.)

Intel Atom 1 Core

1.6Ghz

512MB

Basic (4 cam.)

Intel Celeron

2.0Ghz

768MB

Professional (9 cam.) Intel Pentium 2 Cores 2.4Ghz

1GB

Advanced (16 cam.) Intel Core 2 Duo

2GB

2.2Ghz

MPEG4 compression, motion detection enabled

No. of Cameras

CPU

Speed

RAM

Personal (1 cam.)

Intel Celeron

2.2Ghz

512MB

Basic (4 cam.)

Intel Pentium 2 Cores 2.4Ghz

768MB

Professional (9 cam.) Intel Core 2 Duo

2.8Ghz

1GB

Advanced (16 cam.) Intel Core 2 Quad / i7 2.6Ghz

2GB

B.2. ViTrax Client Computer Specifications Minimum
Requirements
No. of Cameras

CPU

Speed

RAM

Personal (1 cam.)

Intel Celeron

2.2Ghz

512MB

Basic (4 cam.)

Intel Pentium 2 Cores 2.4Ghz

768MB

Professional (9 cam.) Intel Core 2 Duo

2.8Ghz

1GB

Advanced (16 cam.) Intel Core 2 Quad / i7 2.6Ghz

2GB
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Appendix C. Technical Support
Asia Pacific, Middle East, Africa
Rosslare Security Products Headquarters
905-912 Wing Fat Industrial Bldg,
12 Wang Tai Road,
Kowloon Bay Hong Kong
Tel: +852 2795-5630
Fax: +852 2795-1508
E-mail: support.apac@rosslaresecurity.com

United States and Canada
1600 Hart Court, Suite 103
Southlake, TX, USA 76092
Toll Free:+1-866-632-1101
Local:+1-817-305-0006
Fax: +1-817-305-0069
E-mail: support.na@rosslaresecurity.com

Europe
Global Technical Support & Training Center
HaMelecha 22
Rosh HaAyin, Israel 48091
Tel: +972 3 938-6838
Fax: +972 3 938-6830
E-mail: support.eu@rosslaresecurity.com

South America
Pringles 868, 1640 Martinez
Buenos Aires
Argentina
Tel: +54 11 4798-0095
Fax: +54 11 4798-2228
E-mail: support.la@rosslaresecurity.com

Web Site: www.rosslaresecurity.com
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